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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
ur¢ena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uZivatelskou prirucku. Obsahuje dilezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po prilozen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
nédkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

€ Varovani

Pouziti kontrol, Uprav nebo postupt jinym

zpUsobem nez je stanoveno v této dokumentaci

muZze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivanf vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor pffmému slune¢nimu
zdfenf, velmi silnym jasnym svétlim a
udrzujte jej mimo dosah jinych zdroju tepla.
Dlouhé vystaveni tomuto typu prostredf

muze mit za ndsledek zménu barev a
poskozeni monitoru.

*  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skrfice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjectho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

* Vzdy pouzivejte napdjeci kabel schvéleny
spolecnostf Philips. Pokud napd jeci kabel
chybi, obrat'te se na nejblizsi servisnf
stredisko. (Viz informace o strediscich
zdkaznické péce)

*  Béhem pouZivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

*  Pfi pouzivani nebo premistovéni do
monitoru nekopejte a zabrarite pripadnému
padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; prfi zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsf dobu pouZzivat,
odpojte jej ze zasuvky.

e Pred ocisténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Cisti¢e s obsahem
¢pavku.

» Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérmé vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

* Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite ciz( ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouZzivejte
na mistech vystavenych teplu, primému
slunecnimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZivejte jej na mist&, které splfiuje
nasledujici rozsahy teplot a vihkosti.



1. Diilefié

* Teplota: 0-40°C 32-95°F
*  Vlhkost: 20-80% relativni vihkosti

DULEZITE: Pfed ponechanim monitoru
bez dozoru vzdy aktivujte sporic¢ obrazovky.
Bude-li na vasem monitoru zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazeni
nehybného nebo statického obrazu mdze
zpusobit , vypaleni obrazovky, rovnéz
zndmé jako ,dosvit" nebo ,,zobrazeni
duchd”.

,Vypaleni*, ,dosvit" nebo ,,zobrazen{
duchl" je dobre zndmy jev u technologie
panelt LCD. V mnoha pripadech ,,vypdleni,
,, dosvit" nebo ,zobrazeni duchd" postupné
zmizf po urcité dobé mimo provoz.

0 Vystraha

Véazné priznaky ,vypdleni*, , dosvitu" nebo
,,zobrazenf duchd" nezmizf a nelze je opravit. Na
vyse uvedené poskozen( se nevztahuje zdruka.

Servis

Kryt pldsté maze otevrit pouze kvalifikovany
servisni pracovnik.

Pokud je pro opravu vyZadovdna
dokumentace nebo integrace, obrat'te se
na nejblizsf servisni stfedisko. (Viz kapitola
, Stredisko zakaznické péce')

Informace o preevézeni najdete v Casti

,, Technické Udaje".

Neponechévejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je tr'eba provést po
provedeni pokynU v této prirucce, obratte se na
servisntho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zpUsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strankdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf

pozndmky, upozornénf a vystrahy. Jejich pouZitf
je nasledujict:

€& Poznamka

Tento symbol oznacuje dllezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zaf{zenl nebo ztrdte dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobg a nemusi byt uvozeny symbolem.V

takovém pripade je konkrétni vyznacenf vystrahy

nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.




2. Sestaveni monitoru 2] Namontujte stojanek podstavce
1. Umistéte monitor obrazovkou dold na

mekky a hladky podklad, aby nedoslo k
poskrdbdni obrazovky.

2.1 Instalace
2. Pripojte sloupek podstavce k monitoru tak,

El Obsah krabice aby zaklapl do pozice.
Start

PHILIPS

3. Uchopte monitor obéma rukama a
pripevnéte stojanek podstavce do sloupku
podstavce.

VGA (nepovinny) DVI (nepovinny)




Bl Pripojeni k pogitadi

PHILIPS

(1) Vstup stridavého napdjenf

© VstupVGA

© Vstup DVI-D (k dispozici pro vybrané
modely)

O Audio vstup (k dispozici pro vybrané
modely)

© Zimek proti krddeZi Kensington

Pripojeni k pocitaci

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjecl
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.

5. Zapnéte pocitat a monitor. Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

a Popis vyrobku z ¢elniho pohledu
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Slouzi k ZAPNUTI aVYPNUT(
napdjeni monitoru.

o O

Slouzi ke vstupu do nabidky
® =/O0K|OsD.

Potvrzen( nastaveni OSD.

Slouzi k ndvratu na predchozf

o < droven OSD.
O & |Nastaveni trovné jasu.
© | A V¥V [SlouZi k dpravém nabidky OSD.

o Slouzi k dpravé nastavenf
o hlasitosti reproduktoru.

FO] | Zmeéna forméatu zobrazen.

© | AUTO |Automatické nastaveni monitoru.




2. Sestavenl monito

Bl Popis zobrazeni funkci na obrazovce Nabidka OSD

. , NiZe je uveden celkovy pohled na strukturu
dk: D)?
Co je nabidka na obrazovce (OSD) OSD. Tento prehled mlzete vyuzit, budete-li

Funkci nabidky obrazovky (On-Screen Display, chtit pozdé&ji prozkoumat riznd nastavent.

OSD) jsou vybaveny viechny monitory
LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru primo prostrrednictvim — Input E
zobrazeného okna s pokyny. Nize je uveden
priklad prijemného rozhrani obrazovky:

Main menu Sub menu

VGA

DVI
(available for selective models)

. — Picture Format — Wide Screen, 4:3
Model 226V3LA: I
— Brightness — 0~100
— Contrast — 0~100
— SmartContrast — On, Off
— Volume — 0~100
— Audio — Stand-Alone — On, Off
— Mute — On, Off
(available for selective models)
— Color Temperature —— 6500K, 9300K
— Color
— sRGB
— User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuii, IR, Turkge

r— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
L— OSD Time Out — 5s, 10s, 20s, 30s, 60s
L
L L Setup — Auto
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes, No
Zakladni a jednoduché pokyny k ovladacim
L Information

tlacitkim

Ve vyse uvedené nabidce obrazovky OSD
muzete stisknutim tlacitek ¥ A na prednim
rédmecku monitoru pohybovat kurzorem a
stisknutim OK potvrdit vybér nebo zménu.



El Poznimka k rozligeni

Tento monitor je urcen pro optimdlni vykon
pri nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pfi jiném rozlisenf, na
obrazovce se zobrazi vystraha: Pro optimalni
vysledek pouzijte rozliseni 1920 x 1080 pri 60
Hz.

Zobrazovan( vystrahy na nativnf rozlisenf Ize
vypnout v ¢asti Setup (Nastaveni) v nabidce
OSD.

Bl Fyzické funkce
Naklon

2.3 Odpojte stojanek podstavce a
podstavec

Bl Demontaz stojanku podstavce

Nez zacnete demontovat podstavec monitoru,

postupujte podle pokynt nize, aby se zabranilo

jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou doli na
mekky podklad, aby nedoslo k poskrdbdnf
obrazovky.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

w

Pro odpojen( sloupku podstavce stisknéte
uvolfiovacf tlacitko.




H Demontaz podstavce

1. Mdzete zasunout plochy Sroubovdk do
dvou uvolriovacl otvord na krytu zavésu a
jemnym pacenim jej odstrarite.

2. Odmontujte 4 Srouby a potom sejméte
podstavec z monitoru.




3. Optimalizace Obrazu

3.1 SmartContrast

El Cojeto?

Jedinecnd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastn pomér monitoru LCD pro maximdlni
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsvicen( pro jasnéjsi, ostrejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Proé to potrebuii?

Zadéte nejvy¥f vizudlni gistotu a pohodli
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky rfdi kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazeni her a videa
nebo pro zobrazenf jasného, citelného textu
pro kancelarskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete zZivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném Case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicen. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zdzitek pri prohlizeni fotografil nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhranf na obrazovce. Slozita nastavenf jsou
minulosti, protoze tento uzivatelsky prijemny
software vas provede jemnym vyladénim
rozlisent, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zaloZeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovéjsi
technologil v jddrovém algoritmu pro rychlé

zpracovan( a odezvu, je pripraven rozsitit vasi
zkusenost s monitory Philips!

El Instalace
* Postupujte podle pokynd a dokoncete
instalaci.

*  Mulzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, miZete klepnout
na zastupce na pracovni plose nebo na
panel ndstrojd.

PHILIPS oo i pomwelczere

Monitor driver and software installation

Prvni spusténi —Wizard (Privodce)

*  Pfi prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Privodce).

» Tento prlvodce vds provede podrobnym
nastavenim vykonu monitoru.

* Prlvodce mdZete rovné€Z spustit pozdéji z
nabidky Plug-in (Zdsuvny modul).

* Dalsi moznosti mlzete nastavit bez
privodce prostrednictvim podokna
Standard (Standardni).




3. Optimalizace Obrazu

B i 3 - Poien 27900 (30713000801
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SmartControl Lite PHILIPS SmartControl Lite

Wizard

- =
= = =

]

[ -

E1 Spusténi s podoknem Standard
(Standardni):

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umozriuje

SmartControl Lite

upravit Brightness (Jas), Contrast (Kontrast), |+
Focus (Ohnisko), Position (Poloha) a \g
Resolution (Rozlisent). '
*  Muizete postupovat podle pokynd a provést \‘ o
nastavent. == 2R
*  Cancel (Storno) vyziva uzivatele, chcete-li = -
ukonit instalaci. \g -
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SmartControl Lite PHILIPS \g
Brighiness o
=
e SmartControl Lite
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PHILIPS

Contrast
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Focus
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PHILIPS

Position
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3. Optimalizace Obrazu

W Seastczenel

SmartControl Lite

3- P 2330 (csaerisoneon) (%

PHILIPS

Resolution

=

Nabidka Color (Barva):

Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveﬁ cerné), White
Point (Bily bod), Color Calibration (Kalibrace
barev).

MU0Zete postupovat podle pokyni a provést
nastavent.

V nésledujici tabulce vyhledejte polozku
podnabidky na zakladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace
barev)

W Santensel 3-Phken 22381 (53380001} ()%
SmartControl Lite PHILIPS

Black Level

wibes Pt - o +

taoe Garrea = )
-
e Fave
Stans
ah

Smwtimage
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SmartControl Lite
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SmartControl Lite
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e ot
J
Optons. Caltertn

et
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SmartControl Lite

2+ ke 22 (esrsonon) (T
PHILIPS

White Point
Wiite Pomnt &

2Py 7258 (cx30ris0080nt) (X

PHILIPS

Display Gamma

- Paie 22901 pEeTison00nt| (D%
PHILIPS

Calibration




3. Optimalizace Obrazu

1. Tlagitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdji sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazeni pred/po.

4. Chcete-li se vrétit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazenf nejsou k dispozici.

6. Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

* Tlacftko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

*  Tlacitko Next (Dalsi) slouzi k prechodu na
nasleduijici cil (6 cild).

»  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

* Tlacitko Cancel (Storno) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviraci
nabidce Options (Moznosti). Na nepodporova-
ném zobrazovacim zarizeni' s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (MoZnosti).

[ B 3 - P 22903 (cs3073000081) %

SmartControl Lite PHILIPS

Preferences.

e
Optiong Pranrs

Zobrazi nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazi
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovni
plose klepnutim pravym tlacitkem mysi na
mistni nabfdku. Volbou moZznosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

PoloZka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



*  PoloZka Run at Startup (Spustit pfi startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespusti pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto policko nenf zaskrtnuté
(Deaktivovdno), Zddna predvolba nastavena
pro spusténi pri startu nebude nactena.

* Enable transparency mode (Aktivovat reZim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je 0 % neprdhlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zafizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Napovéda)
a Options (Moznosti). Zddné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

e ' T

SmartControl Lite PHILIPS

Input

EPORTANT!

& =
=
e

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudiniho zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
SmartControl Lite

PHILIPS

Audio

]
= (&

Help>User Manual (Napovéda>Uzivatelska
prirucka) — Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

T ;

=

SmartControl Lite PHILIPS

User Manual

£
)

a4 f

= e e

y ;E.



Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru
polozky Version (Verze) v rozeviraci nabidce
Help (Napovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).

[ e 1 (T
PHILIPS

SmartControl Lite

Version

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti
Options > podokno Preferences (Moznosti >
podokno Predvolby).

@ SmartControl
Helect Preset L3
Tune Display

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktualné vybrand
predvolba je oznacena zaskrtnutim. V
rozevirac nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.
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* Tune Display (Ladéni zobrazeni) — otevr'e
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem lze spustit aplikaci.

Help

Technical Support
Check For Update
About

Exik

Hlavni panel obsahuje pét polozek:

* Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobrazi stranku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazi Uvodn( stranku PDI a porovnad verzi
uzivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

*  Exit (Konec) - ukoncf SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitae nebo restartujte pocital.

PHILIPS

SmartControl

SEanConticl
Verzion 3.20
diune. stareard JOOOT-01-04-11 §1.23
Copymght 1683.2007 Partrat Displays i
Paeaees fanang




Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
cast EXIT (KONEC). Cheete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(Moznosti>Predvolby).

15



4. Technické udaje

Typ panelu LCD

TFT-LCD

Podsvicenf

LED

Velikost panelu

215" S (54,6 cm)

Pomér stran

16:9

Roztec¢ obrazovych bodu

0,248 x 0,248 mm

Jas (typ.) 250 cd/m?
SmartContrast 10.000.000:1
Kontrastni pomér (typ.) 1000:1
Doba odezvy (typickd) 5ms

Optimalni rozlisen{

1920 x 1080 pri 60 Hz

Zorny Uhel

170° (H) / 170° (V) pii C/R>10

Vstup signalu

Barevnost displeje 16,/M
Vertikdlni obnovovac( frekvence | 56Hz - 76Hz
Horizontdlnf frekvence 30kHz - 83kHz
sRGB ANO

DVI-D (digitélni), VGA (analogovy)

Vstupnf signdl

Usnadnéni pro uzivatele

Oddélend synchronizace, synchronizace podle zelené

226V3LA:
226V3L:

AUTO/ ¥
AUTO/ ¥

1q/A
/A

0/ 4
0/ 4

/0K 0}
/0K )

Jazyky nabidky OSD

anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusena ¢instina, portugalstina, turectina

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif
Plug & Play

Néklon

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

226V3LA:

Zapnuto

23,77W (typ.), 31,6W (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupnf
napéti pri T00VAC
+/-5VAC,

Strfdavé vstupnf
napéti pri 115VAC
+/-5VAC,

Stridavé vstupnf
napéti pri 230VAC
+/-5VAC,

50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
Normélni provoz (typ.) 20,63W 2049W 20495W
Spanek (Pohotovost) 0,5W 0,5W 0,5W
Vypnuto 0,5W 0,5W 0,5W

Rozptyl tepla*

Stridavé vstupnf
napéti pri T00VAC
+/-5VAC,

50Hz +/-3Hz

Strfdavé vstupnf
napéti pri 115VAC
+/-5VAC,

60Hz +/-3Hz

Stridavé vstupnf
napéti pri 230VAC
+/-5VAC,

50Hz +/-3Hz
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BéZzny provoz

70,41 BTU/hr 69,93 BTU/hr 69,93 BTU/hr

Spanek (Pohotovost)

1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Vypnuto

1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Indikdtor napdjenf

Zapnuto: Bild, Pohotovostn( rezim/rezim spanku: Bild (blikd)

Napdjenf Vypidleni, 100-240VAC, 50/60Hz
226V3L:
Zapnuto 2325W (typ.), 28,71TW (max.)

Spotreba energie (Metoda

Stridavé vstupnf Strfdavé vstupnf Stridavé vstupni
napéti pri T00VAC | napéti pri 115VAC | napéti pri 230VAC

testovani EnergyStar 5.0) +/-5VAC, +/-5VAC, +/-5VAC,
50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
Normalni provoz (typ.) 20,98W 20,85W 20,94W
Spanek (Pohotovost) 0,5W 0,5W 0,5W
Vypnuto 0,5W 0,5W 0,5W

Rozptyl tepla*

Stridavé vstupnf Strfdavé vstupnf Stridavé vstupni
napéti pri TOOVAC | napétl pri 115VAC | napéti pri 230VAC

+/-5VAC, +/-5VAC, +/-5VAC,
50Hz +/-3Hz 60Hz +/-3Hz 50Hz +/-3Hz
B&Zny provoz 71,6 BTU/hr 71,16 BTU/hr 71,47 BTU/hr

Spédnek (Pohotovost)

1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Vypnuto

1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Indikdtor napdjenf

Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bila (blikd)

Napdjenf

Vypaleni, 100-240VAC, 50/60Hz

Vyrobek s podstavce (SxVxH) 532 x 397 x 209 mm

Vyrobek bez podstavee (SxVxH) | 532 x 336 x 44 mm
Vyrobek s podstavcem 3,52kg

Vyrobek bez podstavce 3,36kg

Vyrobek s obalem 4,88kg

Teplotni rozsah (provoz) 0°C az 40 °C
Teplotni rozsah (mimo provoz) -20°C az 60°C
Relativni vihkost 20% az 80%

Pouzirdnf: + 12 000 stop (3 658 m)

Nadmorsid vyska Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.

ROHS ANO

EPEAT Silver (www.epeat.net)

Balenf 100% recyklovatelny
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4.Technické udaje

Prohldseni o shodé CE Mark, FCC Class B, GOST, SEMKO, TCO Certified (Only for
selective models), UL/cUL, BSMI, 1ISO9241-307,CB Energy star 5.0
PSB,CCC,CECP
Barva Cemnd
Povrchova Uprava Leskd/Textura
© Poznimka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.

Tyto Udaje se mohou zménit bez prredchoziho ozndmeni. Stéhnéte si nejnovéjsi verzi letdku z webu
www.philips.com/support.

N




4.1 Rezimy rozliSeni a prredvoleb

EH Maximalni rozli$eni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitalni vstup)

E1 Doporuéené rozliseni
1920 x 1080 pri 60 Hz (digitalni vstup)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
49,70 1280 x 800 59,81
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
64,67 1680 x 1050 59,88
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
67,16 1920 x 1080 59,96

© Poznamka

Upozorfiujeme vis, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pri
60 Hz. Pro dosazeni optimaln( kvality zobrazenf
dodrzujte toto doporucené rozlisent.
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5. Rizeni spotreby
5. Rizeni spotreby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

my3i nebo jiného vstupniho zafizenf, monitor se
automaticky ,,probudi*. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

Rezim VESA| Video | H-synch. [ V-synch. | Spotieba energie | Barva indikdtoru LED
) 277 (tp) )
Aktivni ZAP. | Ano Ano 31.6W (max) Bild
Spanek [ VYP. Ne Ne <05W (typ) Bild (blikd)
Vypnuto | VYP. - - < 05W (typ.) VYP.

ReZim VESA| Video | H-synch. | V-synch. | Spoteba energie | Barva indikitoru LED
L 2325W (typ.) 5
Akti ZAP. Al Al Bil:
vni no no 28,71 W (max) ila
Spanek | VYP. [ Ne Ne | <O05W (typ) B4 (blikd)
Vypnuto | VYP. - - <05W (typ) VYP.

Nasledujici konfigurace se pouzivd pri mérenf
energetické spotreby tohoto monitoru.

» Nativni rozlisenf: 1920 x 1080

* Kontrast: 50%

e Jas: 250 nitC

» Barevnd teplota: 6500 K s pIné bilym

vzorkem

& Poznimka
Tyto ddaje se mohou zménit bez predchoziho
oznament.
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6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(www.epeat.net)

ew, ' The EPEAT (Electronic Product
Qe,'b Environmental Assessment Tool)
, & program evaluates computer

desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

*  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

+ EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

6 Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



6. Informace o regulaci

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

*  Augmenter la distance entre I'équipement
et le récepteur.

* Brancher '€quipement sur un autre circuit
que celui utilisé par le récepteur.

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it ia a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The ussr of the
davics is obligad to take all staps necessary o remove sources of interfarance to tels-
communication or ather devicas.

Pokd neni na fypovém &ithu potstase uvedena, #e spedé dodo tiidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zatazend do tFidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-ii k rullan! telskomunikataich nebo
finjich zafizeni e uivatal povinnen provést takova opatfgni, atry rueni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
Useadzende powiano byt zasilane # gaiazds 2 preylgceonym obwodem ochronmym (gndaedo &
Kalkiem. Wapi\'sdmgact iz o urzaelzenla (koenguter, moniti, drukarka) powiniy byt zsilane
160 sEego
nstalacja clelarycans pomlexaczenia poinna sawiert w prswozle gy resewana achrone
proeel warciami, w pestaci bezpieczntka o vartote mamicnawe nie wigkszej niz 164 (amperio).
W el calkewitego wylpeeeia urqdzenia 2 sieer zasilanta, naledy wyjad wiyeeke kabla
easilaigeepo 2 priaedka, Kidre powinno enyidowad sig w pobliz udemna 1 byt Batwo dostepne.

Zaak bezpiecsefstwa "B” potwiendss podnosé uresdseia 2 wynaganiami bezpiecsehstva
weytkowania zawartymi w PN-S3T42107 § PR-89E06251.

Pozostale instrukcje begpieczensiwa

* Nie ety wrywad wiycsek sdapterowych lub usuwaé kolka abwodu ochronnega 2 wiyeeki.
Jebel bortocne jes upycie perdiutsces to nalery iy proedlufaces 3-pylowcgn 2

System y malezy ieceyd preed naggymi, i wirostami fub spod-
K mapsecia, wiywajae eliminators procpiee, urradrenia dopasajicego i

berzakliceniowegn irodia asilania.

* DNaluiy upewnié sig, sby nic nie lezalo na kablsch systemu komputerowego, araz aby kable nie
byly umlesacaone w mligse, adase mokna byloby na aie nadeptywad b porykad she o e,

* i maledy rouewad napayiow s nayel plya s systens koeputesony.
Nie naleiy wpychat adnych p dve systerm . iy moie
1o spowndwat peiar \uhpm}m\e;r.(dcm poprzes rwarcie lementin wewngtrenych
* Systems kompaterowy powisien snajdowad s 2 dals od graejaikim i dridel clepla. Possdto,
e ey blakawas atword weniylacyjnych. Nalezy unika bladzensa lafnyel papserdw gud
karmputera w i cyrhalacii powi-
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZHARERIIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



6. Informace o regulaci

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postupl vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektiim
obrazovych bodd nebo dil¢ich obrazovych
bodl u panelt TFT LCD, které se pouzivajf
pro ploché monitory, se nicméné nékdy neda
zabranit. Zadny vyrobce nemuize zarudit, ze
viechny panely budou bez defektd obrazovych
bodu, ale spolec¢nost Philips zarucuje, ze kazdy
monitor s neprijatelnym poctem defektl bude
v ramci zdruky opraven nebo vymeénén.Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Uinosnou Uroveri chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zaru¢nf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodl panelu TFT LCD preséhnout
tuto Uroveri dnosnosti. Na monitoru napriklad
nesmi byt vice defektnich dil¢ich obrazovych
bodl nez 0,0004 %. Ddle, protoze nékteré typy
kombinacf vad pixeld jsou Iépe postrehnutelné
nez jiné, stanovuje pro né spolec¢nost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvétove.

subpixely subpixely subpixely

vy
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skldda ze tif
subpixeld v zdkladnich barvdch cervené, zelené a
modré. Kdyz je mnoho pixell pohromadé, tvor{
obraz. Kdyz viechny subpixely urcitého pixelu
svitf, jevi se tyto tii subpixely spolecné jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevi
se tyto tfi subpixely jako jeden cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rliznych barev.

Druhy pixelovych vad

Vady pixelll a subpixeld se na obrazovce
projevuji riiznymi zpusoby. Existuj dva druhy vad
pixelu a v rdmci téchto druhu je nékolik typd
subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dilei
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavd plocha. Existujf

nasledujic typy defektl svétlych bodU:

Jeden Cerveny, zeleny nebo modry subpixel

| ¢

Dva soundleZici subpixely:
- cerveny + modry = fialovy
- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



€ Poznamka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedn( body.

Defekty tmavych bodl

Defekty tmavych bodu se projevuif jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena svétld plocha.
Existuji nasledujici typy defektd tmavych bodu:

KAZY JASNYCH BODU

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného

typu, které se vyskytujf blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzddlenost vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym bodim v zdru¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bod(, které prekracujf
tolerance uvedené v ndsledujicich tabulkach.

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousedn( trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzdalenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD

5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cernych bodd*

>15 mm

Celkovy pocet kazl ¢ernych bodd viech typl

5 nebo méné

KAZy bodl celkem

Celkovy pocet kazl jasnych nebo ¢ernych bodu viech typl

PRIJATELNY POCET VAD

5 nebo méné

© Poznimka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovdni shody pro elektronickd zobrazovacf zarizen)



7.2 Péce o zakazniky & zaruka

Podrobné informace o zaruce a pozadavku na dodateénou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

A

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

ame elefo e o A o zaka é pece

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
woroe fegm NA Kim Tec doo. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
Jkrane NA E‘z;a;;‘jvice +38 044 245 73 31
el NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary :
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko Cislo zakaznické péce
Brazil 0800-7254101
Vermont
Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina

Cislo zékaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. MacauTel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Ind ) NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
Aeonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA f;‘s Computer System Co. | 471 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
Umlted Arab NA AL SHAHD COMPUTER 00971 4 2276525
Emirates LLC
Israel NA Eastronics LTD 1-800-567000
, : +84 8 38248007 Ho Chi Minh City
Vietnam NA FCZTmsear:'cig‘format'c +84 5113.562666 Danang City
P +84 5113.562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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8. Odstranovani problému a
Casté dotazy

8.1 Odstranovani problému

Na této strance jsou uvedeny problémy,
které mlZze odstranit uZivatel. Pokud problém
pretrvdvd i po vyzkousenf téchto resent,
kontaktujte zastupce sluzeb pro zdkazniky
spolecnosti Philips.

El B&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen
k elektrické zdsuvce a do zadnf ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajenti je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

»  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

* Zkontrolujte, zda je zapnuty pocital.

Tlacitko AUTO nefunguje

32

Automatickd funkce je pouZzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete proveést ru¢nf
Upravy prostrednictvim nabidky OSD.

€& Poznimka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdInf, protoZe je zbyte¢nd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrafiovan{
problémd

*  Pro zajisténi bezpec¢nosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zdstupce sluzeb pro
zékazniky spole¢nosti Philips.

Bl Problémy se zobrazenim

Obraz neni vystredén

»  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovldadacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpelné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

»  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovldadacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Dochazi k vodorovnému blikani

“




*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit®, ,,vypileni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napajeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazen{
duchd. ,Vypdleni*, ,dosvit"* nebo
,,Zzobrazenf duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,,vypdleni”, , dosvit"* nebo
,,zobrazenf duchd" postupné zmizf po urcité
dobé& mimo provoz.

*  Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vaSem monitoru LCD zobrazen
neménici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Véiné priznaky ,vypdleni”, ,dosvitu" nebo
,,zobrazenf duchli' nezmizi a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

*  Nastavte rozlieni zobrazeni pocitace na
stejny rezim, v jakém se nachdzf doporucené
nativni rozlisenf obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

*  Zbyvajicl body jsou normadlni viastnostf
tekutych krystald pouzivanych soucasnou
technologil. Dalsf podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a

rusi
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* MdzZete nastavit intenzitu svétla indikdtoru
,napdjeni v ¢asti Power LED (Indikdtor
LED napdjeni) v &asti Setup (Nastaven)

v OSD Main Controls (Hlavni ovlddaci prvky
nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zdstupce sluzeb pro zdkazniky spolecnosti Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svj monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento

monitor: 1920 x 1080 pri 60 Hz.

*  Odpojte viechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operac¢niho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazeni). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaveni
v poli oznac¢eném ,desktop area” (pracovnf
plocha) presurite posuvnik na 1920 x 1080
obrazovych bodu.

* Klepnéte na ,,Advanced Properties” (Upresnit),
nastavte polozku Refresh Rate (Obnovovact
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovanim kroku 2 a 3
ovérte, zda je pocita¢ nastaven na 1920 x 1080
pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

*  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaka je doporugena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitord LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji
mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmiz.

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pri instalaci ovladacl
postupujte podle pokynd v
uzivatelské prirucce. Pfi prvni instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynt a
vlozte (doprovodny disk CD-ROM),
ktery je soucdsti této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovdny automaticky.

Jak mam upravit rozliseni?
Dostupna rozlisenf urcuje grafickd
karta/ovladac¢ grafiky a monitor.
Pozadované rozlisenf mizete vybrat
v Casti Control Panel (Ovlddacf
panely) systému Windows® v &sti
,Display properties” (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset" (Obnovit)
obnovte vSechna plvodni nastavenf
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmérnym dderdm
a chrdnit jej pred ostrymi nebo
tupymi predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.

Jak Ize Eistit povrch monitoru
LCD?

Pro béZné ¢isténi pouzijte Cisty
a mékky hadrik. Pro dikladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zddna jind
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rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?

Odpovéd:  Ano, nastaveni barev mizete zménit
prostrednictvim nabidky OSD podle
nasledujicich krokd:

e Stisknutim tlacftka ,,OK" zobrazte nabidku

OSsD.

+  Stisknutim tla¢ftka ,,Down" (Sipka dol(i)
vyberte volbu ,,Color* (Barva) a stisknutim
tlacitka ,,OK" prejdéte na nastaveni barev. K
dispozici jsou tfi nastaven( (viz nize).

1. Color Temperature (Teplota barev):

k dispozici je dvou nastavent: 6500K a
9300K. Pfi nastaveni v rozsahu 6500K
vypadajf barvy na panelu ,teplé s
cervenobilym barevnym ténem", zatimco
pri nastaveni teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem".

2. sRGB: standard pro zajisténi sprdvné
prrenosu barev mezi riznymi zar{zenimi
(napf:. digitdni fotoapardty, monitory,
tiskdrny, skenery atd.)

3. User Define (Uzivatelské): uzivatel si mize
zvolit vlastni nastaven( barev upravenim
cervené, zelené a modré slozky.

€& Pozniamka:

Méreni svétla barvy, které vyzaruje predmét pri
zahrvani. Toto mérenf je vyjddieno v absolutnim
méritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004K; jsou cervené; vyssi teploty, jako
napriklad 9300K; jsou modré. Neutrdinf teplota je
bila pri 6504K.

OTAZKA 9:  Lze pFipojit tento monitor LCD
k libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Viechny monitory LCD
Philips jsou pIné kompatibilnf se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac muze byt zapotrebi kabelovy
adaptér. Dalsi informace vam
poskytne nejblizsi obchodnf
zastupce Philips.



8. Odstraniovani problému a casté dotazy
OTAZKA 10: Jsou monitory Philips LCD

Odpoved:

OTAZKA 11:

Odpoved:

(D Vystraha

vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologii Plug-
and-Play v opera¢nim systému
Windows 7,Vista, XP NT, Mac
OSX a Linux.

Co znamena |péni obrazu,
vypaleni obrazu, dosvit nebo
»duch® v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdzZe zpUsobit
,vypdleni* obrazovky, rovnéz
znamé jako ,,dosvit"* nebo
,zobrazen( duchl”. ,Vypalenf*,
,dosvit" nebo , zobrazeni duchd"
je dobre zndmy jev u technologie
paneld LCD.V mnoha pripadech
,vypdleni”, , dosvit" nebo
.zobrazenf duchd"” postupné zmizf
po urcité dobé mimo provoz.
Pred ponechadnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Véazné priznaky ,vypaleni*, , dosvitu" nebo
,,zobrazeni duchd" nezmizi a nelze je opravit. Na
vyse uvedené poskozeni se nevztahuje zaruka.

OTAZKA 12: Pro¢ se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji

zobrazené znaky zubaté okraje?

V4s monitor nejlépe pracuje pri
svém nativnim rozlisenf 1920

x 1080 pri 60 Hz. Pouzivejte
toto rozlisenf pro dosazenf
optimélniho zobrazenf.
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